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Technical Support

If you have difficulties using MeshMagic 3D Modeling Software please read the applicable 
topic before requesting support. If your problem is not covered in this user guide please view 
the up-to-date MeshMagic 3D Modeling Software Online Technical Support at 
www.nchsoftware.com/meshmagic3d/support.html . 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions

If you have any suggestions for improvements to MeshMagic 3D Modeling Software, or 
suggestions for other related software that you might need, please post it on our Suggestions 
page at www.nch.com.au/suggestions/index.html. 
Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nchsoftware.com/meshmagic3d/support.html
www.nch.com.au/suggestions/index.html
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Introduction
MeshMagic 3D is an easy to use tool for viewing and making quick editing changes to meshes 
in the common .STL file format, MeshMagic 3D also supports .3DP, .3DS,  .3MF, .OBJ and 
.PLY file formats.

STL files are commonly used for the meshes created for 3D printing.

MeshMagic 3D features

● Read and write to the standard .STL file format used for 3D printing
● Read and write 3DP, 3DS,  3MF, OBJ and PLY file formats
● Select and edit mesh triangles and vertices, including deletion and duplication
● Add simple cube, sphere and torus shapes
● Change the color of mesh object
● Extrude 3D meshes from 2D line drawings 
● Create 3D meshes from 2D lines drawings by a combination of slicing the drawing then 

rotating each slice to form a 3D solid
● Display both the 3D perspective and 2D orthogonal views for the meshes.
● Create new parts ranging from simple cubes and spheres to 3D shapes converted from 2D 

outline drawings

System Requirements 

Operating System Windows XP / Vista / 7 / 8 / 8.1 / 10

Recommended Windows Vista or later
Video Card DirectX 9.0c compatible 3D accelerated,

with up-to-date drivers
RAM 2 GB
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Model Files
MeshMagic 3D supports reading and writing files in the STL file format.

The STL file format is commonly supported by different 3D printing and modeling interfaces.

Thingiverse.com offer many models in STL format, and several popular 3D printers accept STL 
files to prepare models for fabrication. 

MeshMagic 3D also supports reading and writing files in the 3DP, 3DS,  3MF, OBJ and PLY 
file formats. 

●   3DS is a common file format for transferring models between 3D programs. 

Please note that all colors will be lost when saving to 3DS file format. 

●   3MF file format known as 3D Manufacturing Format is a new 3D printing format designed 
to allow applications to share 3d models. The 3MF Consortium manages the 
3MF specifications. 

The format is designed to fully describe a 3D model for the use with 3D printing 
applications. 

3MF is supported by 3D Builder on Windows. There are a growing number of 3MF models 
available for download. 

●   OBJ file format is commonly used to contain 3D mesh and texture data for game content. 

The meshes that have been created for non 3D printing purposes may require extra work 
to make them suitable for 3D printing. 

Please note that all colors and textures will be lost when saving to OBJ file format. 

●   PLY file format known as the Polygon File Format or the Stanford Triangle Format. 

The format is designed to store 3D data from 3D scanners. 

●   3DP file format known as 3D Pad format is designed to contain 3D meshes and other 
properties for models mainly for the use with MeshMagic 3D. 

Have a look on Thingiverse.com for some interesting 3D models. 
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File Tab
The File tab contains options for working with your files. 

New File (Ctrl + N):  Select this option to begin a new mesh file. The currently opened file will 
be closed, you will be prompted to save any unsaved changes. 

Open File (Ctrl + O): Select this option to open an existing mesh file. The current opened file 
will be closed, you will be prompted to save any unsaved changes if there are any. 

Close File (Ctrl + W): Select this option to close the current file. This option will prompt you to 
save any unsaved changes. 

Save File (Ctrl + S): Select this option to save the current file. This option will keep the current 
file open. 

Save As (Ctrl + Shift + S):  Select this option to save the currently opened file to a new file. The 
currently opened file will become the new file. 

File Properties: Select this option to view the properties of the currently opened mesh file. 

Exit (Alt + F4):  Select this option to exit MeshMagic.   
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Home Tab
The Home tab contains options for working with and editing your files. 

File Options 

Common file operations for working with the model files. 

New File (Ctrl + N):  Select this option to begin a new mesh file. The currently opened file will 
be closed, you will be prompted to save any unsaved changes. 

Open File (Ctrl + O): Select this option to open an existing mesh file. The current opened file 
will be closed, you will be prompted to save any unsaved changes if there are any. 

Save File (Ctrl + S): Select this option to save the current file. This option will keep the current 
file open. 

Save As (Ctrl + Shift + S):  Select this option to save the current file with a new name. This 
option will change the currently opened file to the new file. 

Undo/Redo Options 

The Undo / Redo operations allow you undo the last set of changes that you have made to the 
file. 

Undo (Ctrl + Z):  Select this option to undo the last change made to the file. 

Redo (Ctrl + Y): Select this option to redo the last change that the undo command has undone 
to the file. 

Please note that there is a limit to number of operations remembered in the Undo history and 
that the Undo / Redo history is reset at the start of a new session. 

Object Selection 

Please refer to the Object Selection section for this button's usage. 

Create 3D Objects 

Add simple objects to the model space. 

Add Cube: Select this option to add a simple cube mesh. The new mesh will be placed on the 
edit grid at the origin 

Add Sphere: Select this option to add a simple sphere mesh. The new mesh will be placed on 
the edit grid at the origin. 

Add Icosahedron:  Select this option to add a simple 20 sided icosahedron mesh. The new 
mesh will be placed on the edit grid at the origin. 
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Add Torus: Select this option to add a simple torus mesh. The new mesh will be placed on the 
edit grid at the origin. 

Object Properties   

Properties:  Select this option to show the properties of the selected object. 
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Edit Tab
The Edit tab contains options for working with and editing your files. 

Undo/Redo Options 

The Undo / Redo operations allow you undo the last set of changes that you have made to the 
file. 

Undo (Ctrl + Z):  Select this option to undo the last change made to the file. 

Redo (Ctrl + Y): Select this option to redo the last change that the undo command has undone 
to the file. 

Copy/Cut/Paste/Delete Options  

These options allow you to copy and delete the selected items. 

Copy (Ctrl + C): Select this item to copy the selected items to the copy buffer. 

Cut (Ctrl + X): Select this item to cut the selected items from the model to the copy buffer. 

Paste (Ctrl + V): Select this item to paste the items from the copy buffer in to the model. 

Delete (Delete): Select this option to delete the selected items. 

Object Properties   

Properties:  Select this option to show the properties of the selected object. 

Object Selection  

Please refer to the Object Selection section for this button's usage. 

Set and Select Colors  

The color of mesh triangles, including the whole mesh may be changed. 

Color Button: This button shows the current color used when creating new shapes and allows 
you to choose a new custom color.

Any meshes and triangles that are selected will have their colors changed once the color is 
accepted in the color chooser.

To change the color of a part of a mesh object select the faces and/or triangles you want to 
change then choose Apply color from the right-click context menu. 

Color Picker:
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 This button gives you a color picker tool which will set the current color to the color of the 
mesh object you click on. You can use this to copy the colors from one part of the mesh to 
another. You may pick a color from anywhere onscreen for example from a photo being 
displayed by another program. 

Color Apply: This button will apply the current color to the selected objects. 

Note: The Color Apply button will only be enabled after you have chosen a new color with 
either the Color Button or the Color Picker. 

Object Translations    Move Object Button:  This button will allow you to easily move the 
selected objects by using the mouse to drag them.  Hint: You can restrict the movement to a 
single axis by selecting the axis with the Allow Axis  button on the Edit Tab  on the toolbar. 

Rotate Object Button:  You have the option to rotate to an arbitrary orientation by dragging the 
mouse or to select one of the discrete angles from the list. 

●  Rotate by dragging: Choose this option to set the editing mode to rotate mode. The Rotate
Tool  will be shown encompassing the selected item, use the left mouse button to 
drag the selected object to its new orientation.

Hint: You can restrict the rotation to a single axis by selecting the axis with the Allow Axis  
button on the Edit Tab  on the toolbar. 

●  Rotate X-Axis 45°: This will rotate the object 45° around the X-Axis. 
●  Rotate Y-Axis 45°: This will rotate the object 45° around the Y-Axis. 
●  Rotate Z-Axis 45°:  This will rotate the object 45° around the Z-Axis. 
●  Rotate X-Axis 90°: This will rotate the object 90° around the X-Axis. 
●  Rotate Y-Axis 90°: This will rotate the object 90° around the Y-Axis. 
●  Rotate Z-Axis 90°:  This will rotate the object 90° around the Z-Axis. 
●  Rotate X-Axis 180°: This will rotate the object 180° around the X-Axis. 
●  Rotate Y-Axis 180°: This will rotate the object 180° around the Y-Axis. 
●  Rotate Z-Axis 180°:  This will rotate the object 180° around the Z-Axis. 
●  Rotate X-Axis 270°: This will rotate the object 270° around the X-Axis. 
●  Rotate Y-Axis 270°: This will rotate the object 270° around the Y-Axis. 
●  Rotate Z-Axis 270°:  This will rotate the object 270° around the Z-Axis. 

Hint: You may use a series of rotation steps to get your desired orientation. 

Scale Object Button:  This button will allow you to easily scale the selected objects. The Scalin
g Tool  will now be shown encompassing the select item, use either the mouse wheel or 
drag the left mouse button up and down to change the scaling.  Hint: There is a limit to how 
small the scaling tool will let you go, if you need to go smaller try applying Reset Object Origin 
to its own Center which apply the current scaling to the objects vertices and reset the scaling 
tool. 

Allow Axis Movement   

The movement of selected items may be restricted to each of the axes. For example if you only 
want to move an item along the X axis then only have Allow X Movement  selected. 

Allow X Movement:
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 Select this option to allow the selected object to be moved along the X axis. When this option 
is turned off the selected object cannot be dragged along this axis. 

Allow Y Movement:  Select this option to allow the selected object to be moved along the Y 
axis. When this option is turned off the selected object cannot be dragged along this axis. 

Allow Z Movement: Select this option to allow the selected object to be moved along the Z 
axis. When this option is turned off the selected object cannot be dragged along this axis. 

2D Drawing Modes  

The following options take effect on the 2D drawing panels when they are shown. 

2D Draw Mode  

●  Not Drawing:  This is the default option and simply indicates you are not within one of the 
2D drawing modes below. 

●  Draw 2D Circle: Select this option draw a circle in one of the 2D views. Start the circle by 
Left-Clicking on the point for the circle's center then Left-Click where you wish to have the 
Circle's edge. 

●  Draw 2D Ellipse: Select this option draw an ellipse in one of the 2D views. The ellipse is 
drawn to fit a bounding rectangle. Start the bounding rectangle by Left-Clicking a point for 
one corner then Left-Click the opposite corner point. 

●  Draw 2D Line:  Select this option draw a series of continuous lines on one of the 2D views. 
Start the lines by Left-Clicking at the starting point of the first line then Left-Clicking on each 
joining point, to finish the lines click the Right mouse button or press the Escape key. 

●  Draw 2D Rectangle:  Select this option draw a rectangle in one of the 2D views. Start the 
rectangle by Left-Clicking a point for one corner then Left-Click the opposite corner point. 

Once you have a 2D object you can select from the following options: 

●  Extrude 3D from 2D outline: Select this option to create a 3D mesh by extruding a new 
surface from the surface formed by the 2D drawing. 

●  Form 3D from 2D outline (horizontal slices):  Select this option to create a 3D mesh from 
the 2D drawing by effectively rotating each horizontal slice around its vertical axis. 

●  Form 3D from 2D outline (vertical slices): Select this option to create a 3D mesh from the 
2D drawing by effectively rotating each vertical slice around its horizontal axis. 

●  Delete 2D outline: Select this option delete the 2D drawings leaving any 3D meshes in 
place. 
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Tools Tab
Face Normals  

The following options will modify the orientation of the faces in regard the inside/outside 
surfaces of the object. 

Note: When the Backface Culling , found on the View Tab, is set to Do not cull anything faces 
with their normals pointing inwards will appear black, whereas when the Backface Culling  
mode is set to Cull backfaces then they will appear transparent. When the Backface Culling  
mode is set to Draw double sided then reversed faces will still be rendered with their full color. 

Invert Normals: Select this option to invert the normals for each face on the select objects. 
Inverting the normals will flip the direction of the face in regards to which side is treated as its 
outside surface. This does not change the winding order of the triangles that make up object, 
that is, it does not change the order of the vertices that make up each triangle. 

Recalculate Normals:  Select this option recalculate the normals of the faces based on the 
clockwise winding order of the triangles on the selected objects. 

Reverse Winding: Select this option to reverse the current winding order of the faces on the 
selected objects. Note that this will reverse the normals as well.  This will actually will turn the 
object inside out since it changes both the triangle winding order as well as the direction of the 
face normals. 

Mesh Operations  

The following tools allow you to perform operations on the selected objects. 

Duplicate Objects:  Select this option to create copies of the selected objects. The new objects 
will be placed next to their originals. 

Group Objects: Select this option to join the selected objects in to a single object. 

Split Objects: Select this option to split the selected objects in to their separate meshes. 

Cleanup:  Select this option to cleanup the mesh objects. 

●  Remove Duplicated Triangles: Select this option to remove any duplicate triangles from 
within the selected objects, this may take some time on larger objects. 

●  Remove Duplicated Vertices: Select this option to remove any duplicate vertices from 
within the selected objects, this may take some time on larger objects. 

Boolean Operations  

The following tools allow you to perform boolean operations on the selected objects. 

Intersection:
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 Choose this option to reduce the selected meshes to a single mesh which represents the 
intersection of all the selected meshes. Intersection may also be referred to as "A AND B". 

Subtract:  Choose this option to cut away from the first selected mesh all the remaining 
meshes. Subtraction may also be referred to as "A NOT B". 

Union:  Choose this option to create a single mesh which is formed from the surfaces of all the 
selected meshes. Union may also be referred to as "A OR B". 

File Format Converter  

3D Converter:  Select this option to run Spin 3D to convert the currently opened model to any 
supported 3D file format. Note that a copy of the currently opened model will be transferred to 
Spin 3D including all of the unsaved edits. 
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View Tab
The View tab contains options for 3D and 2D view windows. 

Object Drawing Mode 

You may render the model meshes as either solid or wire frame. 

Solid:  Select this option to show the mesh objects in solid form. 

Wire Frame: Select this option to show the mesh objects in wire-frame form. 

Backface Culling  

Select this option to choose whether to hide any hidden triangles using backface culling. 

● Do not cull anything: Select this option to always show all faces. This allows you to view all 
faces while in Wire Frame mode.

● Cull Backfaces:  Select this option to hide the faces that are behind other faces. While in Wir
e Frame  mode only the front-most face edges will be drawn.

● Draw double sided:  Select this option to draw both sides of each face. While in Solid  mode 
both sides of each face will be drawn with the face's material colors. This may be useful if 
the imported mesh faces do not have consistent orientation as regard to the inside/outside 
surfaces of the object.

Please note that triangles are culled if the vertices defining the shape form a counter-clockwise 
angle. This property is also referred to as the triangles Winding Order. 

Specular 

Select this option enable or disable specular highlighting of the drawn objects. 

Perspective View Window 

Reset View (Ctrl + R): Select this option to center the drawing grid in the Perspective View 
window. This will also reset the grid orientation. 

Show Grid (Ctrl + G):  Select this option to show the edit grid in the Perspective View window. 
The X, Y and Z axes are always visible. 

2D and 3D Window Layout 

Select this option to choose the window layout for showing the 3D and 2D views. 

● Hide 2D Views: Select this option to show only the 3D view.
● Show 2D Views on Right Side: Select this option to show the 2D views down the Right 

Side.
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● Show 2D Views at Bottom:  Select this option to show the 2D views along the bottom of the 
window.

● Show 2D Views in Quadrants: Select this option to show all four views as equally sized 
panes in the window.

Object Properties   

Properties:  Select this option to show the properties of the selected object. 

Note: Properties can only be shown for a single selected object. 
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Object Selection
Object Selection  

You are able to select objects and portions of objects through various methods. 

Selecting multiple objects   

To select multiple objects select each object while holding down the Shift key. 

Toggle selections by holding the Ctrl  key down while left-clicking on the object, allowing 
unselected objects to be selected and selected objects to be unselected to and from the 
selection group. 

Multiple objects may also be selected from the 2D views by dragging a selection rectangle 
around them by holding down the Left  mouse button while moving the mouse to draw out a sel
ection rectangle  around the objects you wish to select. 

Actions may be performed on multiply selected objects by holding the Shift key to perform 
actions such as moving, rotating, or scaling all selected objects simultaneously. 

3D Views  
The 3D Object Selection button on the Home Tab will allow you to change the selection mode 
of the type of items that may be selected. 

The following 3D selection modes allow you to select part of the drawing from the Perspective 
View window: 

●  Select Object (Ctrl + Shift + O):  Select this option to select whole 3D meshes within the 
model. 

●  Select Face (Ctrl + Shift + F):  Select this option to select groups of triangles that form a 
common flat face. 

●  Select Triangle (Ctrl + Shift + T):  Select this option to select individual mesh triangles. 
●  Select Edge (Ctrl + Shift + E): Select this option to select individual mesh lines. 
●  Select Vertex (Ctrl + Shift + V): Select this option to select individual mesh vertices. 

Once you have a 3D item selected you may perform operations from the right-click context 
menu. For selected objects you can Delete, Scale, Rotate, Move and Center to the grid origin. 
Selected faces and triangles can be reversed, deleted and duplicated. Selected lines may be 
deleted, duplicated and moved, while selected vertices may only be deleted or moved. 

When you duplicate a face or triangle the new triangles are attached to the mesh at the same 
points the original triangles were using a set connecting triangles around the outside edge of 
the selection. You can use this to extrude a new surface from the mesh. 

While in Select Object  mode you may Copy and Cut selected objects. 

You may Delete  any selected item at any time. 
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You may Paste a copy of the current object from the copy buffer at any time. Pasted objects 
will be placed at the location next to the original object from which it was copied even if the 
original object has been moved or deleted. 

● Select All (Ctrl + A): While in Select Object  mode selects all objects.
● Copy (Ctrl + C): Copy the currently selected objects to the copy buffer.
● Cut (Ctrl + X): Cut the currently selected objects to the copy buffer, removing the currently 

selected objects from the model.
● Paste (Ctrl + V): Paste the objects from the copy buffer to the model.
● Delete (Delete): Delete the currently selected objects from the model.

2D Views   If you have begun to draw a 2D outline by selecting a 2D Drawing Mode 
left-clicking within any of the 2D views will select the shape you have begun to draw, and will 
present you with options for either deleting the shape, or converting the 2D outline into a 3D 
object. 

If you are not currently drawing a 2D outline, left-clicking will select any other object beneath 
the mouse cursor. 

You are able to select many objects simultaneously from within the 2D views by using a selecti
on rectangle . To use a selection rectangle, simply click and hold the Left  mouse button 
within the 2D View, and then drag out the desired rectangle over the objects you wish to select. 

If you have more than 1 object selected, hold the Shift key to perform an actions such as 
moving, rotating, or scaling all selected objects simultaneously. 

Statusbar Display  While in the object move, rotate or scaling modes the corresponding 
values will be displayed on the statusbar at the bottom of the main window. If there is more 
than one object selected then only the values for one of the objects will be shown. In move 
mode the position value shown will be the point of selection on that object. 

15



Right-Click Context Menu
Object Right-Click Context Menu  

This menu appears when Right-Clicking within the Perspective View Window while there are 
objects selected. 

●  Select all (Ctrl + A): Choose this option to select all of the objects in the scene. 
●  Deselect all: Choose this option to deselect the current selections. This is the same as 

Left-Clicking on an empty space in the scene. 
●  Copy selected (Ctrl + C): Choose this option to copy the currently selected objects to the 

copy buffer. 
●  Cut selected (Ctrl + X): Choose this option to cut the currently selected objects to the copy 

buffer. 
●  Delete selected (Delete):  Choose this option to delete the currently selected objects. 
●  Move selected: Choose this option to set the editing mode to move mode. You will be able 

to drag selected items with the mouse.

Hint: You can restrict the movement to a single axis by selecting the axis with the Allow 
Axis button on the toolbar. 

●  Rotate selected: Choose this sub-menu to rotate the select objects. You have the option 
to rotate to an arbitrary orientation by dragging the mouse or to select one of the discrete 
angles from the list. 

● Rotate by dragging: Choose this option to set the editing mode to rotate mode. The Rot
ate Tool  will be shown encompassing the selected item, use the left mouse button 
to drag the selected object to its new orientation.

Hint: You can restrict the rotation to a single axis by selecting the axis with the Allow 
Axis button on the toolbar. 

● Rotate X-Axis 45°: This will rotate the object 45° around the X-Axis.
● Rotate Y-Axis 45°: This will rotate the object 45° around the Y-Axis.
● Rotate Z-Axis 45°:  This will rotate the object 45° around the Z-Axis.
● Rotate X-Axis 90°: This will rotate the object 90° around the X-Axis.
● Rotate Y-Axis 90°: This will rotate the object 90° around the Y-Axis.
● Rotate Z-Axis 90°:  This will rotate the object 90° around the Z-Axis.
● Rotate X-Axis 180°: This will rotate the object 180° around the X-Axis.
● Rotate Y-Axis 180°: This will rotate the object 180° around the Y-Axis.
● Rotate Z-Axis 180°:  This will rotate the object 180° around the Z-Axis.
● Rotate X-Axis 270°: This will rotate the object 270° around the X-Axis.
● Rotate Y-Axis 270°: This will rotate the object 270° around the Y-Axis.
● Rotate Z-Axis 270°:  This will rotate the object 270° around the Z-Axis.

Hint: You may use a series of rotation steps to get your desired orientation. 
●  Scale selected: Choose this option to change the selected object's scaling. The Scaling 

Tool  will now be shown encompassing the select item, use either the mouse wheel or drag 
the left mouse button up and down to change the scaling.
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Hint: There is a limit to how small the scaling tool will let you go, if you need to go smaller 
try applying Reset Object Origin to its own Center  which apply the current scaling to the 
objects vertices and reset the scaling tool. 

●  Center on Grid Origin:  Choose this option to move the selected object to center it on the 
drawing grid's origin. 

●  Reset Object Origin to its own Center:  Choose this option to change the object's center of 
rotation to be the center the selected object.

Note: This will also apply all rotation, scaling and translations directly to the object's 
vertices and reset these tools. 

●  Reset Object Origin to Grid Origin: Choose this option to change the object's center of 
rotation to be the drawing grid's origin.

Please note that the object's new origin is relative to the object so the center will move with 
the object when the object is moved.

Note: This will also apply all rotation, scaling and translations directly to the object's 
vertices and reset these tools. 

●  Apply color: Choose this option to change the selected object's color to the current default 
color as selected by the Color button in the tool bar. See Color Button and Color Picker for 
more details about choosing the current color. 

●  Duplicate Objects:  Choose this option to make a copy of the selected objects, the newly 
created duplicates will be placed next to the originals as separate new objects. 

●  Group Objects: Choose this option to group all the selected objects in to a single 
selectable object. This is useful when you want the grouped object to behave as a single 
object even though it is made up of separate meshes. 

●  Split Objects: Choose this option to separate the object in to separate objects where each 
object contains just a single separate mesh. 

●  Remove Duplicate Triangles: Choose this option to cleanup any duplicated triangles within 
the selected meshes. 

●  Remove Duplicate Vertices: Choose this option to cleanup any duplicated vertices within 
the selected meshes. 

●  Subdivide all triangles into 3: Choose this option to subdivide all of the triangles of the 
selected objects into 3 triangles each. This will create a new vertex at the center of each 
triangle and then join this vertex to each of the three existing vertices, creating three new 
triangles to cover the area of the original triangle. The original triangle is replaced by the 
three new triangles. 

●  Subdivide all triangles into 4: Choose this option to subdivide all of the triangles of the 
selected objects into 4 triangles each. This will create a new vertex at the center of each 
edge, joining each of these new vertices to each other creating a new triangle at the center 
of the original triangle along with three new triangles in the remaining areas. The original 
triangle is replaced by the four new triangles. 

●  Boolean Intersect: Choose this option to reduce the selected meshes to a single mesh 
which represents the intersection of all the selected meshes. 

●  Boolean Subtract: Choose this option to cut away from the first selected mesh all the 
remaining meshes. 

●  Boolean Union: Choose this option to create a single mesh which is formed from the 
surfaces of all the selected meshes. 

●  Object Properties:  Choose this option to open the properties for the selected object. 

Face Right-Click Context Menu  

17

objectpropertiesdialog.html


This menu appears when Right-Clicking within the Perspective View Window while there are 
faces selected. 

●  Reverse face: Choose this option to turn the selected faces inside-out. This is useful when 
there are faces that appear to be facing towards inside the model instead of facing towards 
the outside. 

●  Collapse face:  Choose this option to delete the currently selected faces by collapsing 
each triangle that make up the faces to a single point. 

●  Remove face: Choose this option to delete the currently selected faces from the object, 
this will leave a hole where the faces used to be. 

●  Duplicate face:  Choose this option to duplicate the currently selected faces. This will place 
copies of the selected faces overlaying the originals, joined to the originals along their 
edges. Use this as the first step in extruding a portion of the mesh. 

●  Subdivide face: Choose this option to subdivide the selected faces so that each contained 
triangle is divided into 3 triangles. This will create a new vertex at the center of each 
triangle and then join this vertex to each of the three existing vertices, creating three new 
triangles to cover the area of the original triangle. The original triangle is replaced by the 
three new triangles. 

●  Apply color: Choose this to change the selected face's color to the current default color as 
selected by the Color button in the tool bar. See Color Button and Color Picker for more 
details about choosing the current color. 

Triangle Right-Click Context Menu  

This menu appears when Right-Clicking within the Perspective View Window while there are 
triangles selected. 

●  Reverse triangle: Choose this option to turn the selected triangles inside-out. This is useful 
when there are triangles that appear to be facing towards inside the model instead of facing 
towards the outside. 

●  Collapse triangle:  Choose this option to delete the currently selected triangles by 
collapsing each triangle to a single point. 

●  Remove triangle: Choose this option to delete the currently selected triangles from the 
object, this will leave a hole where the triangles used to be. 

●  Duplicate triangle:  Choose this option to duplicate the currently selected triangles. This 
will place copies of the selected triangles overlaying the originals, joined to the originals 
along their edges. Use this as the first step in extruding a portion of the mesh. 

●  Subdivide triangle into 3: Choose this option to subdivide all of the currently selected 
triangles into 3 triangles each. This will create a new vertex at the center of each triangle 
and then join this vertex to each of the three existing vertices, creating three new triangles 
to cover the area of the original triangle. The original triangle is replaced by the three new 
triangles. 

●  Subdivide triangle into 4: Choose this option to subdivide all of the currently selected 
triangles into 4 triangles each. This will create a new vertex at the center of each edge, 
joining each of these new vertices to each other creating a new triangle at the center of the 
original triangle along with three new triangles in the remaining areas. The original triangle 
is replaced by the four new triangles. 

●  Apply color: Choose this to change the selected triangle's color to the current default color 
as selected by the Color button in the tool bar. See Color Button and Color Picker for 
more details about choosing the current color. 
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Line Right-Click Context Menu  

This menu appears when Right-Clicking within the Perspective View Window while there are 
lines selected. 

●  Collapse line: Choose this option to delete the currently selected lines by collapsing them 
to single points. This will replace to two end points for each selected line with a single point 
near the center position of the line, arranging the triangles around them. 

●  Duplicate line: Choose this option to duplicate the currently selected lines. This will place 
copies of the selected lines overlaying the originals, joined to the originals at their ends to 
form a sheet. This new sheet may be extruded into a solid by selecting the face/triangles 
that make up the sheet then choosing Duplicate face  from the context menu for the 
selected faces. 

●  Move line:  The selected lines may be dragged to a new position by dragging the left 
mouse button while the lines are selected. 

●  Subdivide line: Choose this option to subdivide the currently selected lines into 2. This will 
effectively divide the triangles that share this line as an edge into two triangles each. This 
will place a new vertex at the center of the line then join this new vertex to the opposite 
vertex of each triangle which shares this line as one of their edges. The original triangles 
are replaced by the new triangles. 

Point/Vertex Right-Click Context Menu   

This menu appears when Right-Clicking within the Perspective View Window while there are 
points/vertices selected. 

●  Delete vertex: Choose this option to delete the currently selected vertices. 
●  Move vertex: The selected vertices may be dragged to a new position by dragging the left 

mouse button while the vertices are selected. 

Paste Right-Click Context Menu   

This menu appears when Right-Clicking within the Perspective View Window while there is 
nothing selected and there is something in the copy buffer or there are objects to select. 

●  Paste from Copy Buffer: Choose this option to Paste the objects from the copy buffer to 
the model. This option will only be enabled when there is something in the copy buffer to 
paste. 

●  Select all (Ctrl + A): Choose this option to select all of the objects in the scene. This option 
will only be enabled when there are objects in the scene to select and the selection mode is 
set to Select Object . 
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Controlling the Camera
Controlling the Camera in the Perspective View Window  

The camera can be controlled in a number of ways to get the exact view needed. 

Using the mouse: The easiest way to control the camera is using the mouse.

● The camera may be rotated to view the drawing space from another angle by clicking and 
dragging the right mouse button.

● The camera may be panned by clicking and dragging the middle mouse button.
● The camera can be zoomed in and out by scrolling the mouse wheel up or down.

Using the keyboard: The following keys perform camera actions: 

● Arrow Keys:  Pan the camera in the direction of the arrow key
● Shift+Arrow Keys: Rotate the camera in the direction of the arrow key
● Page Up: Raise the elevation of the camera
● Page Down: Lower the elevation of the camera
● Home: Zoom the camera in
● End: Zoom the camera out

The camera view may be reset to the default orientation by clicking the Reset View button in 
the View tab or by pressing the Ctrl + R keys. 
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Object Properties
Object Properties  

This is an interactive display of the currently selected object's properties.

The object will be modified as you change the values in the properties dialog. You may revert 
back to the original values by clicking the Cancel button or by pressing the Escape key on the 
keyboard.

Position: The object's X, Y & Z position using its current origin relative to the Grid origin. 

Rotation:  The object's rotation relative to its current origin. 

Scale:  The object's scaling. You may change the X, Y & Z to different values to change the 
object's aspect ratio. 

Number of triangles: This shows the current number of triangles that make up the object. 

Default button: This will set the properties to the following pre-sets: 

● Position set to the Grid origin (X = 0.0, Y = 0.0 & z = 0.0)
● Rotation set to the unrotated state (X = 0.0, Y = 0.0 & Z = 0.0)
● Scale set to unscaled (X = 1.0, Y = 1.0 & Z = 1.0)

Please note that the Object Properties  option is enabled only when there is a single object 
selected.
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Keyboard Shortcuts
MeshMagic Keyboard Shortcuts  

Toolbar Selection: 

● Alt + F:  File Tab
● Alt + H:  Home Tab
● Alt + E: Edit Tab
● Alt + T:  Tools Tab
● Alt + V: View Tab

Camera Controls: 

● Arrow Keys:  Pan the camera
● Shift + Arrow Keys:  Rotate the camera
● Page Up/Page Down Keys:  Move the camera up and down
● Home/End Keys: Zoom the camera in and out

Shortcut Keys: 

● Ctrl + A: While in Select Object  mode this will select all of the objects in the scene
● Ctrl + C: Copy the currently selected objects to the copy buffer
● Ctrl + X: Cut the currently selected objects to the copy buffer, removing the currently 

selected objects from the model
● Ctrl + V: Paste the objects from the copy buffer to the model
● Ctrl + P: Display the properties for the selected object
● Ctrl + N: Create a new file, prompt to save changes to the current file if any
● Ctrl + O: Open an existing file, prompt to save changes to the current if any
● Ctrl + S: Save the current file
● Ctrl + Shift + S: Save the current file with a new name (Save As) 
● Ctrl + W: Close the current file, prompt to save changes if any
● Ctrl + G: Toggle the display of the Drawing Grid in the Perspective View
● Ctrl + R: Reset the camera view in the Perspective View Window
● Ctrl + Z:  Undo the last change
● Ctrl + Y: Redo the last Undo
● Delete:  Delete the select item
● Ctrl + Shift + O:  Set Object Selection mode
● Ctrl + Shift + F: Set Face Selection mode
● Ctrl + Shift + T: Set Triangle Selection mode
● Ctrl + Shift + E: Set Edge Selection mode
● Ctrl + Shift + V: Set Vertex Selection mode
● F1: Open help menu 
● Alt + F4: Exit MeshMagic
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NCH Software Suite
This is a useful way to browse all the software available from NCH Software

You can see a set of products by type like Audio, Video and so on and view the product. From 
there you can try out the product and it will download and install it for you to trial. If you already 
have the product installed then you can click "Run It Now" and the program will be launched for 
you.

There is also a list of features for products in the category. Click on a feature, such as "Edit a 
Video File", to install a product with that ability.

Search  

Search our website for products matching any keywords you type. 

See more of our software 

Browse our website for more software. 

Subscribe to our newsletter  

You can subscribe to our newsletter for announcements of new releases and discounts. You 
can unsubscribe at any time. 

See the latest discounts for purchase 

See the latest discounts we are offering for purchasing our products. 
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Software License Terms
This EULA limits our liability and is governed by an arbitration agreement and venue 
agreement. Please read below as these terms affect your rights.

1. The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. Installation 
of this software and any software bundled with or installed-on-demand from this software, 
including shortcuts and start menu folders, is licensed only in accordance with these terms.

2. By installing, using or distributing the software you, on your own behalf and on behalf of your 
employer or principal, agree to be bound by these terms. If you do not agree to any of these 
terms, you may not use, copy, transmit, distribute, nor install this software - return it to the 
place of purchase within 14 days to receive a full refund.

3. This software, and all accompanying files, data and materials, are distributed "as is" and with 
no warranties of any kind, whether express or implied except as required by law. If you intend 
to rely on this software for critical purposes you must test it fully prior to using it, install 
redundant systems and assume any risk.

4. We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for all 
claims is limited to receiving a full refund for the amount you paid for the software.

5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You may not use this software if you 
do not regularly backup your computer, or do not have antivirus and firewall software installed 
on the computer, or keep sensitive data unencrypted on your computer. You agree to 
indemnify us from any claims relating to such unauthorized use.

6. You may copy or distribute the installation file of this software in its complete unaltered form 
but you may not, under any circumstances, distribute any software registration code for any of 
our programs without written permission. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location where the 
unauthorized use occurs.

7. Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage statistics in limited circumstances.

8. Choice of Law. If you reside in the United States, your relationship is with NCH Software, 
Inc, a United States company, and this agreement is governed by the laws and courts of 
Colorado. If you reside anywhere in the world outside of the United States, your relationship is 
with NCH Software Pty Ltd, an Australian company, and this agreement is governed by the 
laws and courts of the Australian Capital Territory. Such courts have continuing and exclusive 
jurisdiction over any dispute between you and us, regardless of the nature of the dispute.

9. U.S. Customers Only: Arbitration Agreement and Class Action Waiver: PLEASE READ THIS 
CAREFULLY. IT MAY AFFECT YOUR RIGHTS.
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If you reside in the United States, NCH Software and you agree to arbitrate all disputes and 
claims between us. This agreement to arbitrate is intended to be broadly interpreted. 
References to "NCH" "you," and "us" include our respective subsidiaries, affiliates, agents, 
employees, predecessors in interest, successors, and assigns. This arbitration agreement 
does not preclude you from bringing issues to the attention of U.S. federal, state, or local 
agencies. Such agencies can, if the law allows, seek relief against us on your behalf. This 
Agreement evidences a transaction in interstate commerce, and thus the Federal Arbitration 
Act governs the interpretation and enforcement of this provision. This arbitration provision shall 
survive termination of this Agreement.

A party who intends to seek arbitration must first send to the other, by certified mail, a written 
Notice of Dispute ("Notice"). The Notice to NCH should be addressed to:

Legal Department

NCH Software, Inc.

6120 Greenwood Plaza Blvd, Ste 120

Greenwood Village CO, 80111

USA 

("Notice Address"). The Notice must (a) describe the nature and basis of the claim or dispute; 
and (b) set forth the specific relief sought ("Demand"). If NCH and you do not reach an 
agreement to resolve the claim within 30 days after the Notice is received, you or NCH may 
commence an arbitration proceeding. The amount of any settlement offer made by NCH or you 
shall not be disclosed to the arbitrator.

A. The arbitration will be governed by the Commercial Arbitration Rules and the Supplementary 
Procedures for Consumer Related Disputes (collectively, "AAA Rules") of the American 
Arbitration Association ("AAA"), as modified by this Agreement, and will be administered by the 
AAA. The AAA Rules are available online at adr.org, by calling the AAA at 1-800-778-7879, or 
by writing to the Notice Address. The arbitrator is bound by the terms of this Agreement. All 
issues are for the arbitrator to decide, including issues relating to the scope and enforceability 
of the arbitration provision. Unless NCH and you agree otherwise, any arbitration hearings will 
take place in Greenwood Village Colorado. If your claim is for $10,000 or less, we agree that 
you may choose whether the arbitration will be conducted solely on the basis of documents 
submitted to the arbitrator, through a telephonic hearing, or by an in-person hearing as 
established by the AAA Rules. If your claim exceeds $10,000, the right to a hearing will be 
determined by the AAA Rules. Regardless of the manner in which the arbitration is conducted, 
the arbitrator shall issue a reasoned written decision. NCH will pay all AAA filing, 
administration, and arbitrator fees for any arbitration initiated in accordance with the notice 
requirements above. If, however, the arbitrator finds that either the substance of your claim or 
the relief sought in the Demand is frivolous or brought for an improper purpose then the 
payment of all such fees will be governed by the AAA Rules. In such case, you agree to 
reimburse NCH for all monies previously disbursed by it that are otherwise your obligation to 
pay under the AAA Rules. In addition, if you initiate an arbitration in which you seek more than 
$75,000 in damages, the payment of these fees will be governed by the AAA rules.
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B. The arbitrator may award declaratory or injunctive relief only in favor of the individual party 
seeking relief and only to the extent necessary to provide relief warranted by that party's 
individual claim. YOU AND NCH AGREE THAT EACH MAY BRING CLAIMS AGAINST THE 
OTHER ONLY IN YOUR OR ITS INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR 
CLASS MEMBER IN ANY PURPORTED CLASS OR REPRESENTATIVE PROCEEDING. 
Further, unless both you and NCH agree otherwise, the arbitrator may not consolidate more 
than one person's claims, and may not otherwise preside over any form of a representative or 
class proceeding. If this specific provision is found to be unenforceable, then the entirety of this 
arbitration provision shall be null and void.

C. Notwithstanding any provision in this Agreement to the contrary, we agree that if NCH 
makes any future change to this arbitration provision (other than a change to the Notice 
Address) you may reject any such change by sending us written notice within 30 days of the 
change to the Arbitration Notice Address provided above. By rejecting any future change, you 
are agreeing that you will arbitrate any dispute between us in accordance with the language of 
this provision.

D. To opt out of this Arbitration Agreement and class action waiver send an Opt Out notice to 
the Notice Address stating "I am electing to opt out of the Arbitration Agreement and class 
action waiver contained in the Legal Terms applicable to my purchase of an NCH product." 
Your Opt Out Notice must include the date and proof of purchase. The Opt Out Notice must be 
postmarked no later than thirty (30) days after the date of purchase. A separate Opt Out Notice 
must be sent for each product purchased.
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